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LabelWorks LW-600P User's Guide
Welcome to the LabelWorks LW-600P User's Guide.
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Introduction to Your LabelWorks Printer
See these sections to learn more about your label printer and this manual.
Product Box Contents
Notations Used in the Documentation
Label Printer Parts

Product Box Contents
Make sure your label printer box included all of these parts:

1 Printer
2 Sample tape cartridge
3 AC adapter
4 USB cable

Parent topic: Introduction to Your LabelWorks Printer
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Notations Used in the Documentation
Follow the guidelines in these notations as you read your documentation:
• Warnings must be followed carefully to avoid bodily injury.
• Cautions must be observed to avoid damage to your equipment.
• Notes contain important information about your label printer.
• Tips contain additional label printing information.
Parent topic: Introduction to Your LabelWorks Printer

Label Printer Parts
Front

1 The power button
2 The error light
3 The battery light
4 The Bluetooth light
5 Tape cover tab
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6 Tape ejection slot
7 Tape cover

Back

1 Bluetooth button
2 Power port
3 USB port
4 Battery cover
5 Security cable attachment point

Parent topic: Introduction to Your LabelWorks Printer
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Setting Up the Printer
Follow the instructions in these sections to set up your label printer.
Connecting the AC Adapter
Installing Batteries
Inserting and Removing Tape Cartridges
Turning the Printer On and Off

Connecting the AC Adapter
Use the AC adapter to power the printer without batteries.
1. Connect the adapter to the printer's AC adapter port.

2. Plug the other end of the adapter into an electrical outlet
Parent topic: Setting Up the Printer

Installing Batteries
You can use batteries instead of the AC adapter when you are not near a power source. The printer
requires 6 AA alkaline batteries.

Caution: Make sure the power is off before you install batteries.
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Note: Batteries are not included.

1. Press the tab and open the battery cover.

2. Insert the batteries with the + and – ends facing as shown.
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3. Replace the battery cover.

Parent topic: Setting Up the Printer

Inserting and Removing Tape Cartridges
You can use LabelWorks tapes with widths ranging from approximately 0.25 inch (6 mm) to 1 inch (24

mm). Use only tape cartridges with these marks:
For a complete list of available tape cartridges, go to epson.com/labelworks (U.S.) or
epson.ca/labelworks (Canada).
1. Make sure the power is off before you install or remove a tape cartridge.

http://www.epson.com/labelworks
http://www.epson.ca/labelworks


14

2. Remove any slack from the tape using a pencil or pen.

3. Lift up the tape cover.
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4. Insert the cartridge as shown and press it down firmly until it snaps into place.
Make sure the end of the tape slides into the ejection slot.

5. Close the tape cover.

To remove a tape cartridge, open the cover, grasp the sides of the tape, then lift it out of the printer.



16

Parent topic: Setting Up the Printer

Turning the Printer On and Off
Make sure the AC adapter is connected or batteries are installed.
• To turn on the printer, press the power button.

The Bluetooth light turns on.

Note: The Bluetooth light flashes at differing intervals depending on the Bluetooth status.

• To turn off the printer, press the power button.
The printer turns off automatically if it is not used within these time periods:
• 8 hours on AC power
• 20 minutes on battery power
Parent topic: Setting Up the Printer
Related references
Product Error Messages
Related tasks
Connecting the AC Adapter
Installing Batteries
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Using the Label Printer With Your Mobile Device
Follow the instructions in these sections to use the label printer with your mobile device.
Installing iLabel
Enabling Bluetooth Discovery Mode
Connecting the Label Printer to Your Mobile Device

Installing iLabel
Download the Epson iLabel app from the Google Play Store or the App Store.
Parent topic: Using the Label Printer With Your Mobile Device

Enabling Bluetooth Discovery Mode
Check that Bluetooth is enabled on the printer before connecting.
The Bluetooth light pulses when Bluetooth is enabled.

If Bluetooth is disabled, enable it by following the steps below:
1. Press the power button to turn off the printer.
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2. Press the power button and the Bluetooth button at the same time.

The printer powers on and the Bluetooth light pulses.
3. Pair your device to the printer using the instructions for your device's operating system.
Parent topic: Using the Label Printer With Your Mobile Device

Connecting the Label Printer to Your Mobile Device
Follow the instructions in these sections to connect the printer to your mobile device.
Connecting the Printer to Your Android Device
Connecting the Printer to Your iOS Device
Parent topic: Using the Label Printer With Your Mobile Device
Related references
Solutions to Problems Pairing with Bluetooth

Connecting the Printer to Your Android Device
You can connect the label printer to your Android device using Bluetooth.
1. Turn on your mobile device.
2. Go to Settings > Wireless & Network and turn on Bluetooth.
3. Wait while your device scans for the printer.

The printer is displayed when your device finds it.
4. Tap the printer.
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Pairing is complete when the printer is listed in the paired devices list.

Note: The Bluetooth icon in the status bar on your device does not change after pairing is
complete, nor does the connection status display on the Bluetooth settings screen.

5. Open iLabel.

6. Tap the icon.
7. Tap Printer.
8. Tap LW-600P.
The printer is ready to use when you see this icon on the main screen of iLabel:

Parent topic: Connecting the Label Printer to Your Mobile Device

Connecting the Printer to Your iOS Device
You can connect the label printer to your iOS device using Bluetooth.
1. Turn on your mobile device.
2. Go to Settings > Bluetooth and turn on Bluetooth.
3. Wait while your device scans for the printer.

The printer is displayed under Devices when the printer is found.
4. Tap the printer.
Pairing is complete when the Bluetooth light on the printer is lit (not flashing).
Parent topic: Connecting the Label Printer to Your Mobile Device
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Using the Printer With Your Computer
Follow the instructions in these sections to use the label printer with your computer.
Connecting the Printer to Your Computer
Using Label Editor for Windows
Using Label Editor Lite for OS X

Connecting the Printer to Your Computer
To use the software with your LabelWorks printer, you need to connect the printer to your computer with
the included USB cable.
1. After you install the software (or during the software installation if prompted), connect the USB cable

to the printer and your computer.

2. Press the power button on the printer.
Parent topic: Using the Printer With Your Computer

Using Label Editor for Windows
The Label Editor software makes it easy to create labels and ribbons using your Windows computer, as
described in these sections.
Getting Started With Label Editor
Designing Labels With Label Editor
Creating Special Format Labels Using Label Editor
Printing Labels With Label Editor
Parent topic: Using the Printer With Your Computer
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Getting Started With Label Editor
Follow the instructions in these sections to get started using Label Editor for Windows.
Installing Label Editor
Starting Label Editor
Label Editor Main Window
Label Editor Toolbars
Parent topic: Using Label Editor for Windows

Installing Label Editor
Download the software from Epson's support website.Visit the driver download site (U.S. downloads or
Canadian downloads).
1. Follow the instructions on the screen to install both the application and the driver.
2. When you are prompted to connect the printer to your computer, connect it using the included USB

cable.
Parent topic: Getting Started With Label Editor
Related tasks
Connecting the Printer to Your Computer

Starting Label Editor
After you have installed the Label Editor software and connected the printer to your computer, you can
start using Label Editor.

1. Double-click the Label Editor icon on your Windows Desktop.

http://www.epson.com/support
http://www.epson.ca/support
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You see this window:

Note: If you want to go directly to the main screen when you start Label Editor, check Do Not
Display This Dialog at Startup.

2. Select your printer and tape width, if necessary.
3. Do one of the following and click OK (or click Cancel to go straight to the main Label Editor screen):

• To start with a blank label, select Horizontal Text.
• To create labels with text from a spreadsheet or other file, select Import (Horizontal Text).
• To start with a ready-made label from the catalog, select Label Catalog.
• To create an equipment management label or QR code label, select one of the Shortcut options.
• To open a previously created label, select Open File and locate the file on your computer, or

select View History and select from a list of existing labels.
Parent topic: Getting Started With Label Editor
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Label Editor Main Window

1 Operation guide bar
2 Edit toolbar
3 Text toolbar
4 Font box
5 Green handle
6 Label area (The red line indicates the area that will be printed.)
7 Workspace (You can temporarily move a block to this area outside the label.)
8 Font size box
9 Layout toolbar
10 Standard toolbar

Parent topic: Getting Started With Label Editor
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Label Editor Toolbars
The toolbars on the main window provide easy access to the main features of Label Editor.

Edit toolbar

Select a block for editing

Draw a line or shape on your label
Click the arrow next to the icon to see the available shapes, including polygons, stars, freehand
lines, and Bézier curves
Open a window that lets you design a table to insert on your label

Open a window that lets you design a ribbon with repeated text or graphic elements, to be printed
on ribbon tape

Standard toolbar

Resize the selected block to fill the label area

Cut the selected block

Delete the selected block

Copy the selected block

Paste data from the clipboard

Undo the last action
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Redo the last undo action

Open the properties window for the selected block

Feed the tape

Feed and cut the tape

Layout toolbar

Rotate the selected block 90° counterclockwise

Rotate the selected block 90° clockwise

Center the selected block vertically on the label

Center the selected block horizontally on the label

Evenly distribute multiple blocks horizontally

Evenly distribute multiple blocks vertically

Align the selected block at the beginning of the label

Align the selected block at the end of the label



26

Text toolbar

Make the selected text bold

Make the selected text italic

Underline the selected text

Reverse the selected text and background (change black text on white background to white on
black)
Change the text style
Click the arrow next to the icon to select outlining and other special effects
Align the text with the left side of the block

Align the text in the center of the block

Align the text with the right side of the block

Justify the text so it is spaced evenly in the block

Change the text direction from horizontal to vertical by clicking the arrow next to the icon

Resize the text box to fit the contents

Resize the text to fill the text box

Parent topic: Getting Started With Label Editor

Designing Labels With Label Editor
Follow the instructions in these sections to design a variety of labels and ribbons.
Creating a Basic Label in Label Editor
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Setting Default Preferences in Label Editor
Working With Blocks in Label Editor
Adding Borders in Label Editor
Inserting Images in Label Editor
Inserting Symbols in Label Editor
Inserting Barcodes in Label Editor
Inserting QR Codes in Label Editor
Inserting Tables in Label Editor
Inserting the Date and Time in Label Editor
Inserting a Background Pattern in Label Editor
Inserting Lines and Shapes in Label Editor
Inserting Text Art in Label Editor
Editing Layout in Label Editor
Editing Text Design in Label Editor
Parent topic: Using Label Editor for Windows

Creating a Basic Label in Label Editor
You can easily create a label with text and graphics and print it on your label printer.
1. Start Label Editor, select Horizontal Text, and click OK.
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You see a blank label on the main Label Editor screen:

2. Enter text in the label, then click outside the label.
You see your text on the label surrounded by a red line with green handles like this:
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3. To change the font and size, select the text box and select the font name and font size from the
selection boxes. (You can use any font installed on your computer.)

4. To save your label, click the Save icon, enter a file name, and click Save.
5. When you are ready to print, click the Print icon.

You see a window like this:

6. Select the number of labels you want in the Copies box.
7. Click OK to print.
Parent topic: Designing Labels With Label Editor
Related tasks
Editing Layout in Label Editor
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Editing Text Design in Label Editor
Setting Default Preferences in Label Editor

You can define default settings for the Label Editor screen, text formatting and printing options, and other
features.
1. Open the Settings menu and select Preferences.

You see a window like this:

2. Select any of the tabs to display the available options.
3. Select the options you want to use as default settings.
4. To select colors, click the Color bar and select from the color chart that appears.
5. When you finish selecting default preferences, click OK.

Note: Some settings take effect immediately, some are applied to the next object you create, and
others are applied the next time you start Label Editor.

Parent topic: Designing Labels With Label Editor
Working With Blocks in Label Editor

Every element that you can add to a label is a block. You can format individual blocks of text or other
elements such as graphic symbols, dates, and tables.
1. To add a text block to a label, click the Text icon.
2. Begin typing anywhere on the workspace.
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Your text appears as you type it in.
3. To select the text block you have typed, click outside the text.

Green handles appear around the text block:

4. Do any of the following:
• To move the block, simply click and drag it as desired. You can add multiple blocks to a label by

dragging them to the right of an existing block on the label area. The label automatically expands
to accommodate the new block.

• To add text to an existing text block, click the Text icon, click within the block, and type in the text.
• To format the text block, click the block to select it and use any of the tools on the text toolbar or

the font selection boxes. You can also click the Properties icon to open a window with
formatting options.

• To resize the text block, click the block to display the green handles. Click and drag one of the
handles on the left or right side to the size you want.

Parent topic: Designing Labels With Label Editor
Related tasks
Editing Layout in Label Editor
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Adding Borders in Label Editor
You can select from a variety of borders for your labels and ribbons.
1. Enter the text for your label.
2. Click the Border icon.

You see this window:

3. Select the border you want and click OK.
The border appears on your label.

4. Do the following to adjust the size of the border and position of the text, if necessary:
• To make the border wider, click and drag on the right side of the border. The white label area

expands as you drag the border.
• To adjust the position of the text, click and drag the text block.

5. When you are finished, click OK.
Parent topic: Designing Labels With Label Editor
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Related tasks
Working With Blocks in Label Editor

Inserting Images in Label Editor
You can add your own logos, photos, or graphics to your labels and ribbons.
1. Click the Image icon.
2. Locate and select the file you want to use on your computer and click Open.

You see an outline of your image block.

Note: Color photos or other images appear in black and white only.

3. Drag the block where you want the image to appear, and click the block to display it on your label.
4. Adjust the size and position of the image and text.
5. To adjust the image format if necessary, double-click the image.

You see a window like this:

6. Select any of the tabs to display the available options.
7. Select the options you want.
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8. When you are finished, click OK.
Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Inserting Symbols in Label Editor
You can select from a variety of ready-made graphic symbols to use in your labels and ribbons.
1. Click the Symbol icon.

You see this window:

2. Use the arrows at the top of the window to scroll through the available categories. Use the scroll bar
on the right to scroll through the available symbols in each category.

3. Select the symbol you want and click OK.
You see the outline of the symbol block on the screen.

4. Drag the block where you want it to appear on your label, and click the block to display the symbol.
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5. Adjust the size and position of the symbol and text.
6. To adjust the symbol format, if necessary, double-click the symbol.

You see this window:

7. Select any of the tabs to display the available options.
8. Select the options you want.
9. When you are finished, click OK.
Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Inserting Barcodes in Label Editor
You can create labels with a variety of barcode types for inventory management and asset tagging, such
as this one:
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1. Click the Barcode icon.
You see this window:

2. Select the type of barcode you want to create.
3. To include the code number beneath the barcode, select the Display text checkbox.
4. Enter the code number for your barcode in the Code box.
5. Enter the barcode size, positioning, and font information as necessary, and click OK.

You see a message about adding margins on the sides of your barcode.

Note: If you do not want to see this message, select the Display tab on the Barcode window and
uncheck Message On.

6. Click OK.
You see the outline of your barcode block.

7. Drag the block where you want your barcode to appear, then click the block to display it on your
label.
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Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Inserting QR Codes in Label Editor
You can create labels with a QR code for many purposes, such as linking to URLs, file storage services,
or social media applications. One-inch (24 mm) wide black-on-white tape is recommended for the fastest
QR code recognition.

Note: When embedding content from social media applications, consider your privacy settings. When
embedding content from file storage services, check the sharing settings to ensure that other people can
view the content.

1. Click the QR Code icon.
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You see this window:

2. Select the type of QR code you want to create.
3. Enter the URL or other text in the Code box.
4. Select the Error Correction Level and Symbol Size options as necessary, and click OK.

Note: Small or Medium Symbol Size settings are recommended.

You see a message about adding margins around the QR code.

Note: If you do not want to see this message, select the Display tab on the Barcode window and
deselect the Message On checkbox.

5. Click OK.
You see the outline of your QR code block.

6. Drag the block where you want your QR code to appear, then click the block to display it on your
label.
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Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Inserting Tables in Label Editor
You can add customized tables to your labels.

1. Click the Table icon.
You see this window:

2. Select the table settings you want to use and click OK.
The table appears on your label.

3. To resize the table, click and drag one of the green dots to the size you want.
4. To format the table, select it and click the Properties icon.
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You see a window like this:

5. Select any of the tabs to display the available options.
6. Select the options you want.
7. When you are finished, click OK.
Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Inserting the Date and Time in Label Editor
You can add the date and/or time to your labels and have it automatically updated.
1. Open the Insert menu and select Date and Time.
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You see this window:

2. Select the date, update method, and display format options you want to use.
3. Select any of the tabs to display additional text formatting options.
4. Select the options you want.
5. Click OK.

You see the outline of your date block.
6. Drag the block where you want the date and/or time to appear, then click the block to display it on

your label.
7. If you need to adjust the size, click and drag one of the green handles.
Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor
Editing Text Design in Label Editor

Inserting a Background Pattern in Label Editor
You can select from several background patterns for your labels and ribbons, or create your own graphic
or text background.

Note: All background elements print in light gray.
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1. Open the Insert menu and select Background Pattern.
You see this window:

2. Do one of the following:
• Select one of the available background patterns.
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• To create your own pattern, click Original Background Pattern, and click New. You see this
window:

Use the tools to design your pattern and click OK. Once you have designed a pattern, Label Editor
saves it with the ready-made background patterns so you can use it again.
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• To create a text background pattern, click Text Background Pattern. You see this window:

Enter the text for your background, then select the Font, Style, and Size options you want to use.
3. Click OK.

You see your background pattern on the Label Editor main screen.
Parent topic: Designing Labels With Label Editor

Inserting Lines and Shapes in Label Editor
You can add graphics to your labels and ribbons using a variety of lines and shapes.
1. Click the arrow next to the Straight Line icon.

You see this window:
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2. Click the line or shape you want to draw.

Note: If you select the regular polygon shape, you can choose a polygon (and set the number of
sides) or a star (and set the number and ratio of points).

3. Click on your label on the screen.
Your cursor turns into a pencil.

4. Drag the pencil to draw your line or shape.

Note: For some lines, you need to click to anchor the line segment, then double-click to finish the
line.

5. To format the line or shape, double-click it.
You see a window like this:

Note: The available options vary depending on the line or shape you select.
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6. Select any of the tabs to display the available options.
7. Select the options you want.
8. When you are finished, click OK.
Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Inserting Text Art in Label Editor
You can add curves or other special effects to text on your labels and ribbons.
1. Open the Insert menu and select Text Art.

You see this window:

2. Enter the text for the art, then select the Font, Size, Style, and Text Alignment options you want to
use.

3. Click the Shape tab.
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You see this window:

4. Select the curve and transformation options you want to use.
You see a preview of your text art in the window.

5. Click the Decoration tab.
6. Select any Fill, Border, and Reverse settings you want to use.
7. Click OK.

You see the outline of your text art block.
8. Drag the block where you want the text art to appear, then click the block to display it on your label.
Parent topic: Designing Labels With Label Editor
Related tasks
Working With Blocks in Label Editor

Editing Layout in Label Editor
You can rearrange and adjust the layout of the blocks of text and other elements on your labels.

1. To edit the layout of a block, click the Edit block icon, and click the block on the Label Editor main
screen.

Note: To select more than one block, press and hold the Shift key on your computer keyboard while
you click the blocks (or choose Select All from the Edit menu).

You see green handles around the selected block.
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2. Open the Layout menu.

3. Do any of the following.
• To reposition overlapping blocks, click Block Order and select any of the available options.
• To flip a block horizontally or vertically, click Flip and select one of the options.
• To rotate a block, click Rotate and select one of the options.
• To align one or more blocks, click Align and select one of the options.
• To reposition a block interactively, click Set Position, select one of the options, click OK, and click

on the label where you want to position the block.
• To reposition multiple blocks interactively, click Arrange Blocks, select one of the options, click

OK, and click one of the blocks.
• To restore the original aspect ratio of an image, click Revert to Default Ratios.

Note: You can also use the icons on the Layout toolbar to perform many of the same functions.

Parent topic: Designing Labels With Label Editor
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Related tasks
Working With Blocks in Label Editor

Editing Text Design in Label Editor
You can use the Text Settings window to apply more text formatting options to your label than those
available in the Text toolbar or Text menu.
1. Click a text block on the Label Editor main screen to select it.

You see green handles around the selected block.
2. Click the Properties icon.

You see this window:

3. Select any of the tabs to display the available options.
4. Select the options you want.

You see a preview of the text in the window.
5. When you finish selecting text settings, click OK.
Parent topic: Designing Labels With Label Editor

Creating Special Format Labels Using Label Editor
Follow the instructions in these sections to create special format labels using Label Editor.
Creating Labels from Imported Data in Label Editor
Creating Ribbons With Repeated Patterns in Label Editor
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Creating Equipment Management Labels in Label Editor
Using the Label Editor Catalog
Creating Numbered Label Sequences in Label Editor
Parent topic: Using Label Editor for Windows

Creating Labels from Imported Data in Label Editor
You can create a series of labels using the data from one or more spreadsheet columns. This lets you
quickly create address labels from your entire address book, for example.
The following file formats are supported: .csv, .txt, .xls, .xlxs, and .xlsm.

Note: To use .xls, .xlxs, or .xlsm file formats, you must have Microsoft Excel installed on your computer.

1. On the New/Open screen, select Import(Horizontal text) and click OK.
You see this window:

2. Click Load Import Data, select the file you want to import, and click Open.
3. Select Overwrite Current Data and choose a data sheet, if necessary.
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You see a Layout window and a Data window side by side:

4. Click the Import icon.
You see a window like this:

5. Select one of the columns that you want to import and click OK.
You see the outline of an import frame.
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6. Drag the frame where you want the data to appear on your label.
You see the data from the current row on the label layout:

7. Repeat steps 5 and 6 until all the data you want to import appears on the label.
8. Adjust the size and position of the import frames as necessary.
9. To save your label project, click the Save icon, enter a file name, and click Save.
10. To select specific rows to print, click the checkbox to the right of the row number in the Data window.

A green check mark appears next to the row number.

Note: You can select a row in the Data window and see a preview of your label in the Layout
window.

11. Click the Print icon.
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You see a window like this:

12. Select the number of labels you want in the Copies box.
13. Select the options you want in the Data Importing section.
14. Click OK to print your labels.
Parent topic: Creating Special Format Labels Using Label Editor
Related tasks
Creating Equipment Management Labels in Label Editor
Printing Labels in Label Editor
Print-Paste Printing in Label Editor
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Creating Ribbons With Repeated Patterns in Label Editor
You can easily create ribbons with repeated patterns of text and graphics. Load ribbon tape in your label
printer before you print.

Note: For best results, turn off the auto cutter and use scissors to cut the ribbon.

1. Enter the text for your label. You can use normal text or text art for curved or transformed text.
2. Select the font and size for the text.
3. Add symbols, images, or a border, if desired.
4. Click the Ribbon icon.

You see this window:

5. Enter the length of the ribbon and interval between each repeated block.
6. Click OK.

You see a preview of your ribbon design.
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Parent topic: Creating Special Format Labels Using Label Editor
Related tasks
Inserting Images in Label Editor
Inserting Symbols in Label Editor
Adding Borders in Label Editor
Printing Labels in Label Editor

Creating Equipment Management Labels in Label Editor
You can select from several templates for equipment management labels and modify the templates as
necessary. You can create a series of equipment management labels by entering the text manually or by
importing it from a file.
1. On the New/Open screen, select Equipment Management and click OK.

You see this window:
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2. Scroll down to view the available templates, select the one you want to use, and click OK.
You see a window like this:

3. Do one of the following:
• Select Data Entry, enter the text for each field, and click OK.
• Select Data Importing (for Multiple Labels), click Reference, and select the data file you want to

use. Follow the instructions for importing data.
You see a screen like this:
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4. Do any of the following:
• To edit the default field labels, double-click each text block and enter the text you want.
• To format the text you entered, double-click it on the layout window.
• To create additional labels using the same template, enter the text in the Data window. After you

complete each row, a blank row appears below it.
5. To save your label project, click the Save icon, enter a file name, and click Save.
6. Click the Print icon.
7. Select the number of copies and any other settings you want.
8. Click OK to print your labels.
Parent topic: Creating Special Format Labels Using Label Editor
Related tasks
Creating Labels from Imported Data in Label Editor
Printing Labels in Label Editor
Print-Paste Printing in Label Editor

Using the Label Editor Catalog
Label Editor includes a catalog containing a variety of ready-made labels. You can print the existing
labels or customize them as necessary.
1. From the New/Open screen, select Label Catalog, and click OK.
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You see this window:

2. Select a category on the left, then scroll through the label images to select the one you want.

Note: To limit your selection to the tape width you are using, click the arrow under Tape Width and
select the width.

3. To edit a selected label, click Edit.
You see the label on the Label Editor screen. You can use any of the available editing tools to edit
the label blocks.

4. To print a selected label, click Print.
5. Select the number of copies and any other settings you want.
6. Click OK to print.
Parent topic: Creating Special Format Labels Using Label Editor
Related tasks
Editing Layout in Label Editor
Editing Text Design in Label Editor
Printing Labels in Label Editor
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Creating Numbered Label Sequences in Label Editor
You can create copies of a label that are automatically numbered in sequence using numerals or letters
of the alphabet.
1. Create the text for your label.
2. Open the Insert menu and select Alphanumeric Sequence.

You see this window:

3. Select Numerals or Alphabetic Value as the Attributes option.
4. Enter one or more # symbols as the Format option to represent the number of digits you want in your

sequence.
5. For Initial Value, enter the starting number or letter for your sequence.
6. For Increment, enter the value to add for each subsequent label. To create a decreasing sequence,

enter a minus number.
7. For Repetition, enter the number of times to repeat an item in the sequence. To specify a maximum

or minimum value for your sequence, select the Max (min) checkbox and enter the value.
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8. Select the Font, Size, Text Position, and Style options as necessary for the sequence.
9. Click OK.

You see the outline of your sequence number block on the Label Editor main screen.
10. Drag the sequence block where you want the number to appear, then click to display it on your label.
11. If you need to adjust the size, click and drag one of the green handles.
12. To save your label project, click the Save icon, enter a file name, and click Save.
13. Click the Print icon.

You see a window like this:

14. Select the number of copies of each label you want to print.
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15. Select the Paginate with Alphanumeric Sequence checkbox.
16. Click OK to print.
Parent topic: Creating Special Format Labels Using Label Editor

Printing Labels With Label Editor
Follow the instructions in these sections to print using Label Editor.
Printing Labels in Label Editor
Label Editor Printer Settings
Print-Paste Printing in Label Editor
Parent topic: Using Label Editor for Windows

Printing Labels in Label Editor
When you have finished designing a label, you are ready to print.
1. Click the Print icon.
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You see a window like this:

2. Select the number of copies.
3. If you are printing a numbered sequence of labels, select the Paginate with Alphanumeric

Sequence checkbox.
4. If you are printing a series of labels with imported data, select the options you want in the Data

Importing section.
5. To turn off collation when printing multiple copies of labels with imported data, select the Print Order

checkbox in the Import section.
6. If you are using Print-Paste Printing, select the Set Print Range checkbox, then select the sections

you want to print.
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7. To turn off collation when printing multiple copies with Print-Paste Printing, select the Print Order
checkbox in the Print-Paste Printing section.

8. To select additional printing options, click Printer Settings.
You see this window:

9. Select any of the tabs to display the available options.
10. Select the options you want.
11. Click OK to close the window.
12. Click OK to print.
Parent topic: Printing Labels With Label Editor
Related references
Label Editor Printer Settings
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Label Editor Printer Settings
The Printer Settings options let you adjust many label features as you print, including the orientation of
text and mirror printing.

Setting Options Description
Paper tab
Tape Width Various widths available Sets the width of the loaded tape

Get Tape Width: detects the
width of the loaded tape
automatically

Orientation Vertical
Horizontal

Sets the orientation of the label
text
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Setting Options Description
Print Setting Mirror Print Select Yes for mirror-image

printing on clear labels for use on
transparent surfaces

Graphics tab
Resolution 180 dpi Sets the print quality

automatically
Dithering Rough

Fine
Line Art
BW

Sets the method for printing
imported images
BW: lets you set the threshold for
turning grayscale images into
black and white

Concentration –3 to +3 Decreases or increases the print
density

Options tab
Cut Setting Cut each label

Cut after job
Don't cut

Sets how the label is cut
Cut each label: cuts each label
as it is printed
Cut after job: prints multiple
labels in a print job without
cutting
Don't cut: prints all labels
without cutting, so you can cut
them manually

View Setting Display tape width
confirmation message
Print Preview

Displays selected information
before printing

Unit mm(mm)
inches(in)

Selects the units of measurement
used in Label Editor

Utilities tab



66

Setting Options Description
Feed and Cut Select to feed, or feed and cut labels, or to restart the printer driver
Feed
Printer Drivers Restart

Parent topic: Printing Labels With Label Editor
Print-Paste Printing in Label Editor

You can create labels from imported data and select individual data fields or columns to print on
separate labels. For example, instead of including the item name, code, and price on one label, you can
create three separate labels, one for each item. This is called print-paste printing in Label Editor.
1. Create or open a label project with imported data.

You see a label with the layout you have selected.
2. Select the layout window.
3. Click the arrow under Print-Paste Printing(Multiply) on the left side of the screen.
4. Select the number of labels you want to create from each existing label.

You see an expanded area on the layout window, like this:
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5. Drag the import frames from the original label to the additional labels in the display window.
You see your individual print-paste labels, like this:

6. Click the Print icon.
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You see a window like this:

7. Select the Set Print Range checkbox in the Print-Paste Printing section.
8. Select the individual labels you want to print.
9. To turn off collation when printing multiple copies, select the Print Order checkbox in the Print-Paste

Printing section.
10. Select additional print options as necessary.
11. Click OK to print.
Parent topic: Printing Labels With Label Editor
Related references
Label Editor Printer Settings
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Using Label Editor Lite for OS X
The Label Editor Lite software makes it easy to create labels using a Mac, as described in these
sections.

Note: This software is available in English only.

Getting Started With Label Editor Lite
Designing Labels With Label Editor Lite
Feeding and Cutting the Tape in Label Editor Lite
Printing Labels With Label Editor Lite
Parent topic: Using the Printer With Your Computer

Getting Started With Label Editor Lite
Follow the instructions in these sections to get started using Label Editor Lite for OS X.
Installing Label Editor Lite
Starting Label Editor Lite
Label Editor Lite Main Window
Parent topic: Using Label Editor Lite for OS X

Installing Label Editor Lite
Install the Label Editor Lite software from the App Store. If you can not access the App Store, you can
download the software from Epson's support website.
1. Open the App Store.
2. Enter Epson Label Editor Lite in the search field and press the button.
3. Click Epson Label Editor Lite in the list of apps.
4. Click Free.

The button name changes to Install App.
5. Click Install App.
6. Download the printer driver from Epson's support website and install it. Visit the driver download site

(U.S. downloads or Canadian downloads).
Label Editor Lite installs on your Mac.
Parent topic: Getting Started With Label Editor Lite

http://www.epson.com/support
http://www.epson.ca/support
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Starting Label Editor Lite
After you have installed the Label Editor Lite software and connected the printer to your computer, you
can start using Label Editor Lite.
1. Choose Applications > Label Editor Lite.

You see the main screen:

Parent topic: Getting Started With Label Editor Lite
Related tasks
Connecting the Printer to Your Computer
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Label Editor Lite Main Window

1 Label preview area
2 File area
3 History area
4 Insert area
5 Text editing area
6 Font settings area
7 Tape length settings area
8 Tape width settings area
9 Printing area
10 Zoom area
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Parent topic: Getting Started With Label Editor Lite

Designing Labels With Label Editor Lite
Follow the instructions in these sections to design a variety of label and ribbon types.
Setting Default Preferences in Label Editor Lite
Creating a Basic Label in Label Editor Lite
Formatting Text in Label Editor Lite
Inserting Images in Label Editor Lite
Inserting the Date and Time in Label Editor Lite
Adding Borders in Label Editor Lite
Inserting QR Codes in Label Editor Lite
Using the Label Editor Lite Wizard
Parent topic: Using Label Editor Lite for OS X

Setting Default Preferences in Label Editor Lite
You can define default settings for the Label Editor Lite screen, text formatting and printing options, and
other features.
1. Open the Epson Label Editor Lite menu and select Preferences.
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You see a window like this:

2. Select the options you want to use as default settings.

Note: The settings are applied to the next object you create.

3. Click OK.
4. Click OK again.

You return to the main window.
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Parent topic: Designing Labels With Label Editor Lite
Creating a Basic Label in Label Editor Lite

You can easily create a label with text and graphics and print it on your label printer.
1. Start Label Editor Lite.

You see the main Label Editor Lite screen:

2. Select the printer and tape width.
3. Enter the text for your label in the text field.

The text appears in the text editing area and the label preview area.
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4. To change the font and size, select the text box, and select the font name and font size from the
selection boxes. (You can use any font installed on your computer.)

5. To save your label, click the save icon, enter the file name, select any tags, and click Save.
6. When you are ready to print, click the print icon.

You see a window like this:

7. Select the number of labels you want in the Copies box.
8. Click Print.

You see a tape width confirmation message.
9. Click OK to print.
Parent topic: Designing Labels With Label Editor Lite

Formatting Text in Label Editor Lite
You can use the Font settings area or the Text menu to format the alignment or basic style of your text.
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1. Enter text or click the text in a label.
2. Do any of the following:

• Change the font by selecting it in the font list
• Emphasize the text using the bold, italic, underline, or strikethrough buttons or menu

options
• Change the text justification using the left justify, center, or right justify buttons or menu

options
• Change the font size in the Font Size list
The text is updated as you select font options.

Parent topic: Designing Labels With Label Editor Lite
Inserting Images in Label Editor Lite

You can add your own logos, photos, or graphics to your labels and ribbons.
1. Click the insert image icon.
2. Locate and select the file you want to use on your computer and click Insert.

Note: Color photos or other images appear in black and white only.

The image appears in the label.
3. Click the image properties icon.

You see this window:
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4. Select the Image Position and Threshold Value options you want to use.
5. Click OK.
Parent topic: Designing Labels With Label Editor Lite

Inserting the Date and Time in Label Editor Lite
You can add the date and/or time to your labels and have it automatically updated.
1. Click the date icon.

You see this window:

2. Select the date format option you want to use.
3. Click OK.

The date appears in the label.
Parent topic: Designing Labels With Label Editor Lite

Adding Borders in Label Editor Lite
You can select from a variety of borders for your labels and ribbons.
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1. Enter text in a label.
2. Click the border icon.

You see this window:

3. Select the Border, Line Style, and Line Thickness options you want to use.
4. Click OK.
The border appears in the label.
Parent topic: Designing Labels With Label Editor Lite

Inserting QR Codes in Label Editor Lite
You can create labels with a QR code for many purposes, such as linking to URLs, file storage services,
or social media applications. One-inch (24 mm) wide black-on-white tape is recommended for the fastest
QR code recognition.
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Note: When embedding content from social media applications, consider your privacy settings. When
embedding content from file storage services, check the sharing settings to ensure that other people can
view the content.

1. Click the QR code icon.
You see this window:

2. Enter the URL or other text in the Code box.
3. Select the QRCode position option you want to use.
4. Click OK.
The QR code appears in the label.
Parent topic: Designing Labels With Label Editor Lite
Related tasks
Printing Labels With Label Editor Lite

Using the Label Editor Lite Wizard
You can choose from a variety of templates to help you design your labels and ribbons.
1. Click the wizard icon.
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You see a window like this:

2. Click the arrow to expand the list of template files.

Note: Template previews appear in the template window.

3. Select a template and click OK.
The template opens on the Label Editor Lite main screen.

4. Edit the template as you would any other label.
Parent topic: Designing Labels With Label Editor Lite
Related tasks
Printing Labels With Label Editor Lite
Formatting Text in Label Editor Lite

Feeding and Cutting the Tape in Label Editor Lite
You can manually feed the tape or ribbon, or feed and automatically cut it.
• Click the feed icon.

The printer feeds a short length of tape or ribbon.
• Click the feed and cut icon.

The printer feeds a short length of tape or ribbon and cuts it.
Parent topic: Using Label Editor Lite for OS X
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Printing Labels With Label Editor Lite
When you have finished designing a label, you are ready to print.
1. Click the print icon.

You see a window like this:

2. Select the number of copies.
3. Select the Mirror Print checkbox if you want the label to print on clear tape to be used on a

transparent surface.
4. Select the Concentration setting to decrease or increase the print density.
5. Select the Cut option you want to use.
6. Click Print.
Parent topic: Using Label Editor Lite for OS X
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Applying Your Labels
Follow the instructions in these sections to apply your printed labels.
Applying Standard Labels
Iron-on Labels

Applying Standard Labels
Your printed labels are easy to attach to most surfaces.

Caution: Depending on the environment and the surface to which you attach them, labels may peel off
or become discolored, and the adhesive may remain on or damage the surface. Epson is not responsible
for any damage or loss due to these causes.
Do not attach labels to human bodies or other living things, or to surfaces that you are not authorized to
modify.

1. Peel off the backing.

2. Place the label on the desired surface and press it down firmly.
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Parent topic: Applying Your Labels

Iron-on Labels
You can apply iron-on labels to the following types of fabric:
• 100% cotton
• 100% linen
• 100% polyester
• Cotton/polyester blends
• Fabrics with a flat, smooth surface

Note: Do not apply iron-on labels to textured fabrics such as terry cloth, corduroy, or flannel; roughly
woven fabrics; fabrics with a rough surface such as denim; waterproof fabrics; or fabrics which require a
cool iron.

Applying Iron-on Labels
Iron-on Label Tips
Parent topic: Applying Your Labels

Applying Iron-on Labels
Press the entire label firmly and do not use steam or a press cloth.
1. Set your iron to 284–320 °F (140–160 °C), without steam.
2. Make sure the area where you want to apply the label is not wrinkled.
3. Place the label in the desired location with the printed side up.
4. Gently press the iron down on one end of the label to temporarily attach it in place.



84

5. Press the iron firmly down on the entire label, holding the iron still for about 10 to 15 seconds.
Repeat this step 3 or 4 times.

Parent topic: Iron-on Labels

Iron-on Label Tips
Keep this information in mind when using iron-on labels:
• Labels are made from non-toxic materials; however, attached labels are stiff, and may rub or scratch

the skin if direct contact occurs.
• Labels are dry-cleanable and machine washable.
• Keep the label length short (up to about half the width of the iron soleplate). Labels that are too long

may be difficult to attach or may look distorted due to the expansion and contraction of the fabric.
• Trimming the corners of the label before attaching it may help prevent it from peeling off the fabric.
• If a label does peel, you can re-apply by ironing; however, it may not adhere as securely to the fabric.
• When applying a label to fabric that may be frequently washed or dry-cleaned, it is recommended that

the label be sewn on.
• When using a steam iron, turn the steam off when ironing on the label.
• Once a label is applied, it cannot be easily removed.
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• Never clean the labels with chemicals or solvents such as benzine, thinner, or alcohol. Otherwise, the
print on the label may become faint or distorted.

• If labels are exposed to direct sunlight for long periods of time, yellowing may occur.
• Iron-on labels do not adhere to non-fabric materials such as paper or leather.
• When using bleach or spot detergent, make sure you test it in advance.
Parent topic: Iron-on Labels
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Cleaning the Printer
Follow the instructions in these sections to clean your label printer.
Cleaning the Outside of the Printer
Cleaning the Print Head

Cleaning the Outside of the Printer
Before cleaning the printer, turn off the power and unplug the AC adapter.
• To remove dust or dirt, use a soft, dry, lint-free cloth.
• To remove stubborn dirt, use a soft cloth moistened with water.

Caution: Do not use benzine, paint thinner, alcohol, or other chemicals to clean the printer. Do not
use canned air or chemical dusters.

Parent topic: Cleaning the Printer

Cleaning the Print Head
If streaks or white lines appear on your labels, you can clean the print head.

Caution: Do not use benzine, paint thinner, or other chemicals to clean the printer. Do not use canned
air or chemical dusters.

1. Turn off the power and unplug the AC adapter.
2. Lift up the tape cover.
3. Grasp the sides of the tape and lift it out of the printer.
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4. Use a dry cotton swab to gently clean the print head as shown.

Parent topic: Cleaning the Printer
Related tasks
Inserting and Removing Tape Cartridges
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Solving Problems
Check the solutions in these sections if you have any problems using the printer.
Checking for Software Updates
Product Error Messages
Solutions to Problems Pairing with Bluetooth
Solutions When the Printer Does Not Print
Solutions to Computer Printing Problems
Solutions When Print Quality Is Poor
Solutions to Tape Cutting Problems
Solutions to Problems With Saved Labels
Solutions to Problems Attaching Labels
Solutions to Problems With Iron-on Labels
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit the driver download site (U.S. downloads or Canadian downloads).
Parent topic: Solving Problems

http://www.epson.com/support
http://www.epson.ca/support
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Product Error Messages
You can often diagnose problems with your label printer by checking the status lights.

1 The error light
2 The battery light
3 The Bluetooth light

Light Condition Printer status
Bluetooth Pulsing Bluetooth enabled

On Bluetooth connection established
Flashing quickly Performing operations such as printing or label cutting
Flashing once every 5
seconds

Bluetooth disabled

battery On Low batteries; replace batteries soon
Flashing quickly Replace batteries
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Light Condition Printer status
error Flashing quickly Printer error; check the message displayed on the

connected computer or mobile device for error
information

Parent topic: Solving Problems
Related references
Where to Get Help
Related tasks
Inserting and Removing Tape Cartridges
Installing Batteries

Solutions to Problems Pairing with Bluetooth
If you connected your mobile device to your printer using Bluetooth, try these solutions:
• Make sure the mobile device's Bluetooth is turned on.
• Check to see if the printer's Bluetooth light is pulsing. If not, enable Bluetooth on the printer and try

pairing with the printer again.
• Check if the printer is communicating with another mobile device. The printer can only communicate

with one device at a time.
• If the printer is connected to a computer with a USB cable, it cannot communicate using Bluetooth.

Disconnect the USB cable and try pairing the printer again.
• Check your mobile device for any messages.
Parent topic: Solving Problems
Related tasks
Installing iLabel
Related topics
Connecting the Label Printer to Your Mobile Device

Solutions When the Printer Does Not Print
If labels do not print or a print job stops, try these solutions:
• Check for messages on the computer or mobile device's display.
• Check that the cables are connected properly or the Bluetooth connection is active.
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• Make sure the printer is selected in the software.
• Make sure you have entered text for your label.
• Replace the tape cartridge if necessary. Make sure the cartridge is correctly inserted.
• Replace the batteries or connect the AC adapter.
Parent topic: Solving Problems
Related tasks
Installing Batteries
Inserting and Removing Tape Cartridges
Connecting the AC Adapter
Turning the Printer On and Off

Solutions to Computer Printing Problems
If you are having trouble printing from your computer, try these solutions:
• Check for messages on the computer screen.
• Make sure the printer is connected to your computer.
• Make sure the printer driver is installed and the computer has been restarted after installation.
• Make sure the correct printer is selected in your software, and the printer is not set as offline.
• Make sure graphics are within the margins of the label.
Parent topic: Solving Problems
Related tasks
Connecting the Printer to Your Computer
Installing Label Editor
Installing Label Editor Lite

Solutions When Print Quality Is Poor
If you see lines or broken text on your labels or ribbons, try these solutions:
• Clean the print head.
• Make sure there is no slack in the tape.
• Try adjusting the print density or concentration.
• Try using a different font for your label or ribbon design.
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Parent topic: Solving Problems
Related references
Label Editor Printer Settings
Related tasks
Cleaning the Print Head
Creating a Basic Label in Label Editor Lite
Creating a Basic Label in Label Editor
Printing Labels in Label Editor
Printing Labels With Label Editor Lite

Solutions to Tape Cutting Problems
If the printer does not cut after printing, try these solutions:
• Make sure the cut setting is selected in the software.
• If you are printing from your computer, make sure the cut setting option is set.
• If the cutter blade is dull, contact Epson for technical support.
Parent topic: Solving Problems
Related references
Where to Get Help
Label Editor Printer Settings
Related tasks
Feeding and Cutting the Tape in Label Editor Lite
Printing Labels With Label Editor Lite
Printing Labels in Label Editor

Solutions to Problems With Saved Labels
If you cannot find a saved label or ribbon design, try these solutions:
• Make sure you have not accidentally deleted the label or ribbon design.
• If you are using the mobile app, check the History list to see if the label has been automatically saved.
Parent topic: Solving Problems
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Solutions to Problems Attaching Labels
If you are having trouble attaching a label, try these solutions:
• Make sure you peel off the backing paper before attaching the label.
• Make sure the surface you are attaching the label to is clean and dry. Labels may not adhere to some

materials, rough or uneven surfaces, or surfaces subject to extreme environmental conditions, such as
high humidity or heat.

Parent topic: Solving Problems
Related tasks
Applying Standard Labels

Solutions to Problems With Iron-on Labels
If you are having trouble applying an iron-on label, try these solutions:
• If labels curl after ironing or fall off after washing, try raising the iron temperature (within the suggested

temperature range).
• Make sure you press the iron down on the entire label.
• Try holding the iron down for 15 to 20 seconds.
• Try trimming the corners of the label.
• If an item needs frequent washing, you may need to sew on the label instead of ironing it.
Parent topic: Solving Problems
Related references
Iron-on Label Tips
Related tasks
Applying Iron-on Labels

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

http://www.epson.com/support
http://www.epson.ca/support
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Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-7245, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
• Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,

Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Purchase Supplies and Accessories
Epson offers a wide array of tapes and ribbons for multiple uses. You can purchase tape cartridges and
accessories at epson.com/labelworks (U.S.) or epson.ca/labelworks (Canada). You can also purchase
supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-
7766).
Parent topic: Solving Problems

http://www.epson.com/labelworks
http://www.epson.ca/labelworks
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Technical Specifications
These sections list the technical specifications of your printer.
Label Editor Software System Requirements
Label Editor Lite Software System Requirements
Mobile Device System Requirements
Label Printer Specifications
Label Printer Power Supply Specifications

Label Editor Software System Requirements
To use the Label Editor software, your computer should meet these requirements:

Operating system Windows 10 (32- and 64-bit)
Windows 8.x (32- and 64-bit)
Windows 7 (32- and 64-bit) SP1
Windows Vista (32- and 64-bit) SP2
Windows XP (32- and 64-bit) SP3

Hard drive space About 300MB
Display 1024 × 768 (XGA) or higher resolution
Interface USB 1.1 Full-speed

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Label Editor Lite Software System Requirements
To use the Label Editor Lite software, your Mac should meet these requirements:

http://www.epson.com/support
http://www.epson.ca/support
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Operating system OS X 10.11.x
OS X 10.10.x
OS X 10.9
OS X 10.8.x
OS X 10.7.x
OS X 10.6.x

Hard drive space About 40MB
Display 1024 × 768 (XGA) or higher resolution
Interface USB 1.1 Full-speed

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Mobile Device System Requirements
To use the iLabel app, your mobile device should meet the following requirements:

Operating system Android
iOS

Communication method Conforms to Bluetooth Specification Version 2.1 + EDR
Output Bluetooth Specification Version Power Class 2
Maximum communication
distance

About 32 feet (10 m)

Frequency band 2.4 GHz band (2.4 to 2.4835 GHz)
Profile SPP

Parent topic: Technical Specifications

http://www.epson.com/support
http://www.epson.ca/support
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Label Printer Specifications
Dimensions
(approximate)

Width:
2.1 inches (54 mm)
Depth:
5.2 inches (132 mm)
Height:
5.7 inches (146 mm)

Weight
(approximate; excluding
batteries and tape cartridge)

0.97 lb (440 g)

Supported tape widths 1/4, 3/8, 1/2, 3/4, and 1 inch
(6, 9, 12, 18, and 24 mm)

Interfaces USB 1.1, Full-speed
Bluetooth

Temperature Operating:
41 to 95 °F (5 to 35 °C)
Storage:
14 to 131 °F (–10 to 55 °C)

Parent topic: Technical Specifications

Label Printer Power Supply Specifications
AC adapter type AST1116Z1-1

dedicated adapter, power cable only
Manufacturer Seiko Epson Corp.
Input AC100–240V, 0.4A, 50–60Hz
Output DC11V, 1.64A
Total output power 18 W
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Battery AA alkaline battery × 6

Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your label printer.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks
Copyright Notice

Important Safety Instructions
Before using your label printer, read and follow these safety instructions.
General Label Printer Safety Instructions
Tape Cartridge Safety Instructions
AC Adapter Safety Instructions
Battery Safety Instructions
Parent topic: Notices

General Label Printer Safety Instructions
• Always use the product as instructed in the manual. Otherwise, damage or injury may occur.
• Do not subject the product to any strong force or shock such as dropping, hitting, or standing on the

product.
• Do not spill liquid on the product or use the product with wet hands.
• Do not open any covers on the product other than the tape cover or battery cover.
• Do not touch the print head.
• Turn the product off, unplug the AC adapter and remove the batteries, and refer servicing to qualified

service personnel under the following conditions: if liquid or foreign objects get inside the product; if
the product does not operate normally or exhibits a distinct change in performance. Continuing to use
the product may result in damage or injury.

• To avoid injury, keep your fingers away from the tape ejection slot when printing or using the cutter.

http://global.epson.com/SR/environment/recycle/?rdct=recycle
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• Do not block or insert objects into the AC adapter port or tape ejection slot.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place or store the product in the following locations: outdoors or in direct sunlight; near sources

of excessive heat, humidity, shocks, vibrations, or dust; where it may get wet or be exposed to
excessive humidity; on an unstable place such as a shaky or inclined surface; near potential sources
of electromagnetic interference such as loudspeakers or the base units of cordless telephones.

• The product and product manuals may come packaged in plastic bags. Keep plastic bags away from
small children to avoid any risk of suffocation.

• If you will not be using the product for a long period, unplug the power cord and remove the batteries.
• Before cleaning, unplug the power cord and remove the batteries. Use only a dry, soft cloth to clean

the product; do not use liquid or chemical cleaners.
• Take care not to cut your fingers when cutting tape with scissors.
• Turn the power off after use.
WARNING: The cords included with this product contain chemicals, including lead, known to the State of
California to cause birth defects or other reproductive harm. Wash hands after handling. (This notice is
provided in accordance with Proposition 65 in Cal. Health & Safety Code § 25249.5 and following.)
Parent topic: Important Safety Instructions

Tape Cartridge Safety Instructions

• Use only compatible LC and LK tape cartridges with these labels: .
• To avoid damage, do not drop or disassemble tape cartridges.
• Feed the tape using the software commands. Do not forcibly pull out the tape. Otherwise, you may

damage the tape cartridge.
• Do not try to print with an empty tape cartridge; this may overheat the print head and damage the

product.

Note: Tape cartridges contain ink ribbons. Make sure to follow local ink disposal regulations.

Parent topic: Important Safety Instructions
Related references
Label Editor Printer Settings
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Related tasks
Printing Labels With Label Editor Lite

AC Adapter Safety Instructions
• Use only the AC adapter and power cord that came with your product. Do not use the AC adapter with

any other equipment and use only with the specified voltage. Using the wrong AC adapter and power
cord may result in damage, overheating, fire, or electric shock.

• Plug the power cord firmly into the outlet. When removing the plug from the outlet, grasp the plug
firmly and do not pull on the cord.

• Make sure the plug is not dusty when inserting it into an outlet.
• Do not hold the plug with wet hands.
• Do not make any modifications to the AC adapter or power cord.
• Place the AC adapter and power cord to avoid abrasions, cuts, fraying, crimping, and kinking. Do not

place heavy objects on top of the AC adapter or power cord.
• Do not use the AC adapter in a confined space or cover it with a cloth. Make sure the AC adapter has

sufficient ventilation so that it does not overheat and become damaged.
• Do not forcibly bend or twist the power cord.
• Do not place the AC adapter or power cord near a heater.
• To avoid fire or electric shock, do not use a damaged AC adapter or power cord.
• Turn off the product before unplugging the AC adapter. Otherwise, it may not function properly or may

become damaged.
Parent topic: Important Safety Instructions

Battery Safety Instructions
• Use batteries properly to avoid injury or fire caused by leaking, overheating, explosion, erosion, or any

other damage to the product.
• Keep batteries out of reach of children. If battery acid gets into your eyes or on your skin, immediately

rinse the affected area thoroughly with water and seek medical treatment. If a battery is swallowed,
seek medical treatment immediately.

• If battery acid leaks from a battery, wipe it off with a cloth and replace the battery with a new one.
• Use AA alkaline batteries.
• Do not use new and old batteries together or mix different types of batteries.
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• Insert batteries so that the polarities (+ and –) are correct.
• Remove dead batteries promptly.
• Do not heat batteries or throw them in fire or water.
• Do not remove batteries with metal objects such as tweezers or the tip of a pen.
• Make sure to follow local battery disposal regulations.
Parent topic: Important Safety Instructions

FCC Compliance Statement
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Caution
Changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate this equipment.
An AC adapter with ferrite core must be used for RF interference suppression.

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
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established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B).
Parent topic: Notices

Trademarks
EPSON® and LabelWorks® are registered trademarks and EPSON Exceed Your Vision is a registered
logomark of Seiko Epson Corporation. LC TAPE, LK, and their logos are registered trademarks or
trademarks of Seiko Epson Corporation. Epson Connection is a service mark of Epson America, Inc.
Google PlayTM and AndroidTM are trademarks of Google Inc.
Mac and OS X are trademarks and App Store is a service mark of Apple Inc., registered in the U.S. and
other countries.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
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product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
Copyright Attribution
Parent topic: Notices

Copyright Attribution
© 2016 Epson America, Inc.
4/16
CPD-40145R2
Parent topic: Copyright Notice
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